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СОЗДАНИЕ КОЛЛАЖЕЙ 

AKVIS Chameleon — программа для тех,  кто любит создавать коллажи и удивительные 
художественные композиции. Chameleon бережет ваше время и силы, так как не требует точного 
выделения объектов и тщательной обработки границ между вставкой и фоном.  Именно поэтому 
программа получила такое название — она "хамелеонит", приспосабливает цвета.  

Программа позволяет изменить свою внешность,  например, пересадить глаза с одной фотографии 
на другую,  нанести на кожу татуировку или боевую раскраску.  Вы можете приделать свое лицо 
на изображение рок-звезды или политического деятеля,  поставить себя рядом с Собором 
Парижской Богоматери или разместиться на фоне любого другого известного места,  вписать 
современную фотографию в классическое полотно.  

Chameleon применяется при оформлении веб-сайтов  и  фотоальбомов,  свадебных снимков,  при 
подготовке рекламных материалов, поздравительных открыток, обоев для рабочего стола.  

С помощью AKVIS Chameleon можно преобразить самый обычный снимок,  добавив в него 
"изюминку".  

Программа работает в четырех режимах:  

Режим Фотомонтаж предназначен для реалистичного совмещения изображений и создания 
иллюзии целостного фото.  Основная часть вставленного фрагмента не изменяется,  а края 
фрагмента сглаживаются и подстраиваются под фоновое изображение.  

Режим Хамелеон полностью адаптирует вставленный фрагмент под фоновое изображение: 
сглаживаются края и изменяется цвет всего фрагмента,  подстраиваясь под окружающие его 
цвета фона.  

Режим Смешивание позволяет добиться интересного эффекта "вплавки" вставленного фрагмента 
в текстуру фона,  когда сквозь вставленное изображение просвечивает рисунок и текстура 
основного.  

Режим Встраивание соединяет два изображения особым образом, так что объект "встраивается" 
в фон отдельными областями,  благодаря чему в некоторых случаях можно добиться совмещения 
сложных по форме объектов.  Уникальность этого режима в том,  что работа идет именно с 
фоновым изображением,  а не вставкой,  сам объект не изменяется,  но на него накладывается 
часть фона.  
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УСТАНОВКА ПРОГРАММЫ 

  

Внимание! Установка программы невозможна без наличия прав администратора.  

Перед установкой плагина необходимо закрыть графический редактор,  в который будет 
устанавливаться плагин.  Если установка плагина была выполнена при запущенном графическом 
редакторе, то его необходимо перезапустить.  

  

Для установки AKVIS Chameleon на компьютер с системой Windows необходимо выполнить 
следующие действия:  

¡ Запустить файл akvis-chameleon-setup.exe.  

¡ Выбрать язык программы установки и нажать кнопку ОК. 

¡ Ознакомиться с Лицензионным Соглашением,  при согласии с его условиями выбрать 
пункт "Я принимаю условия лицензионного соглашения" ("I accept the term in the license 
agreement") и нажать на кнопку Далее (Next). 

 

 

¡ Для установки плагина нужно выбрать из списка графический редактор (или редакторы), в 
который будет устанавливаться плагин.  

Если нужного редактора нет в списке, включить компонент   Своя папка для плагинов

(Custom Plugins Directory) и указать путь к личной папке,  где хранятся все плагины, 
например,  C:\My Plugins или др.  (в последнем случае необходимо убедиться,  что данная 
папка выбрана в настройках графического редактора,  тогда все плагины,  находящиеся в 
ней, автоматически подключатся к редактору).  

Для  ус тановки  версии standalone (отдельной программы)  должен быть выбран 
соответствующий вариант — Standalone.  
Для создания ярлыка программы на рабочем столе должен быть выбран компонент Ярлык 
на рабочий стол (Shortcut on desktop).  

Нажать на кнопку Далее (Next).  
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¡ Нажать кнопку Установить (Install). 

 

 

¡ Запустится процесс установки программы. 
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¡ Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, 
ссылки на обучающие статьи и специальные предложения. Для этого введите свой адрес e-
mail. 

 

 

¡ Нажать кнопку Готово (Finish) для выхода из программы инсталляции.  

После установки программы AKVIS Chameleon в главном меню Start (Пуск)  появится пункт 
AKVIS ->  Chameleon,  a  на рабочем столе — ярлык программы AKVIS Chameleon (если при 
установке было выбрано создание ярлыка).  

После установки плагина Chameleon в меню фильтров (эффектов)  редактора появится новый 
пункт AKVIS – Chameleon.  Используйте эту команду для вызова плагина из графического 
редактора. Например, в Photoshop выберите: Filter - AKVIS - Chameleon. 

Внимание! 
Если плагин не установился в графический редактор автоматически, можно подключить его 
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вручную. 
Обычно достаточно просто скопировать файл 8bf (например,  Chameleon.8bf, Chameleon.8bf) 
в папку Plug-ins графического редактора. Например,  для Adobe Photoshop CS4 плагин нужно 
скопировать в папку Program Files\Adobe\Adobe Photoshop CS4\Plug-Ins.  
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УСТАНОВКА ПРОГРАММЫ 

  

Внимание! Установка программы невозможна без наличия прав администратора.  

Перед установкой плагина необходимо закрыть графический редактор,  в который будет 
устанавливаться плагин.  Если установка плагина была выполнена при запущенном графическом 
редакторе, то его необходимо перезапустить.  

  

Для установки программы на Macintosh необходимо выполнить следующие действия:  

¡ Открыть виртуальный диск dmg 

- akvis-chameleon-plugin.dmg для редакторов Photoshop CS3-CS5, Photoshop Elements 
6-9  
- akvis-chameleon-legacy.dmg для старых версий Photoshop,  Photoshop Elements или 
других совместимых редакторов  
- akvis-chameleon-app.dmg для установки версии standalone (отдельная программа 
Chameleon)  

На экране будет отображено диалоговое окно с Лицензионным соглашением.  

 

 

¡ Ознакомиться с лицензионным соглашением и нажать кнопку Agree.  

¡ Откроется окно Finder с приложением AKVIS Chameleon (в случае установки отдельной 
программы) или, в случае установки плагина, с папкой AKVIS Chameleon PlugIn. 

  

 

Приложение AKVIS Chameleon необходимо перетащить в папку Applications.  

Папку AKVIS Chameleon PlugIn (целиком!) — в папку с плагинами вашего графического 
редактора. Например,  для редактора Photoshop CS3: Applications/Adobe Photoshop CS3/Plug-
Ins.  
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После установки плагина Chameleon в меню фильтров (эффектов)  редактора появится новый 
пункт AKVIS – Chameleon.  Используйте эту команду для вызова плагина из графического 
редактора. Например, в Photoshop выберите: Filter - AKVIS - Chameleon. 

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.  
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РЕГИСТРАЦИЯ ПРОГРАММЫ 

  

Приобрести лицензию на программы AKVIS можно через интернет-магазины Allsoft или Softkey. 
Перейти на соответствующие страницы для заполнения формы можно прямо с сайта akvis.com. 
После заполнения формы и проведения денежной транзакции серийный номер (регкод)  будет 
выслан в течение нескольких минут.  

После получения серийного номера следует перейти к регистрации программы.  

Рассмотрим процесс регистрации программы.  

Внимание! Ваш компьютер должен быть подключен к сети Интернет.  

Если подключение к Интернет недоступно,  ниже предлагается альтернативный способ 
регистрации.  

  

Для регистрации программы необходимо выполнить следующие действия:  

¡ Открыть окно О программе. 

 

 

Окно  О программе всегда показывается при запуске незарегистрированной копии 
программы.  В программе AKVIS Chameleon окно О программе выводится при нажатии 

кнопки  .  Кроме того,  при работе с плагином в редакторе Adobe Photoshop окно О 

программе может быть вызвано на экран выбором команды меню Help -> About Plug-In –> 
Chameleon (Photoshop -> About Plug-In –> Chameleon на Macintosh).  

Обратите внимание,  что функционал программы зависит от типа лицензии.  В течение 
пробного периода доступны все инструменты и любая лицензия.  Выберите тип 
триальной версии (для ознакомительного периода): Home (Plugin либо Standalone), 
Deluxe или Business (внизу содержится пояснительный текст с кратким описанием 
выбранной лицензии). В зависимости от выбора будут доступны разные возможности 
AKVIS Chameleon.  

Кнопка Купить перенаправляет на страницу заказа,  где можно продолжить подбор 
программ для заказа либо приступить к его оформлению.  

Если Вы пользуетесь лицензией Home, в любой момент можно произвести апгрейд до 
Home Deluxe или Business,  доплатив разницу в цене.  Чтобы перейти на страницу 
заказа апгрейда,  выберите желаемую лицензию и нажмите на кнопку Апгрейд
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(которая в зарегистрированной версии появляется на месте кнопки Купить).  

Для получения полной информации о версиях и лицензиях программы AKVIS 
Chameleon смотрите сравнительную таблицу.  

¡ Нажать на кнопку Активировать для запуска программы активации.  

¡ Ввести имя, на которое будет зарегистрирована программа.  

¡ Ввести уникальный серийный номер (регистрационый ключ,  код) ,  полученный после 
оплаты заказа. 

Если у вас нет серийного номера, закажите лицензию (выбрав один из предложенных 
интернет-магазинов). 
Ваш серийный номер (регкод)  будет отослан по электронной почте сразу же,  как 
только деньги поступят на счет интернет-магазина.  

¡ Выбрать способ активации — через прямое соединение или через почту.  Рекомендуемый 
способ активации — через прямое соединение,  как более удобный.  Компьютер на данном 
этапе должен быть подключен к сети Internet. 

 

 

¡ Нажать кнопку Активировать. 

Регистрация программы завершена!  

 

 

Eсли был выбран способ активации через почту,  то при нажатии на кнопку Активировать будет 
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автоматически создано письмо,  которое,  не редактируя,  необходимо отправить на указанный в 
письме адрес. 

Вы получите письмо с вложенным файлом Chameleon.lic,  который следует поместить в папку, 
где хранится лицензионная информация о программе.  Это папка AKVIS в  Общих документах
пользователей:  

¡ Windows Vista, Windows 7: 

Users\Public\Documents\AKVIS 

¡ Windows XP: 

Documents and Settings\All Users\Documents\AKVIS  

¡ Mac OS X: 

Users/Shared/AKVIS или домашняя папка пользователя 

Не стоит пытаться открыть этот файл, просто сохраните его в нужную папку.  

  

Если компьютер не подключен к Internet 

Если компьютер не подключен к сети Internet, можно зарегистрировать лицензию следующим 
образом:  

¡ В качестве способа активации используйте запрос по e-mail.  Создается письмо, 
содержащее данные, которые нам необходимы.  

¡ Запишите это письмо на дискету и отошлите с любого другого компьютера.  Все,  что нам 
нужно, уже будет записано в самом письме.  

¡ Отправьте сообщение, не изменяя его, на указанный в письме адрес сервиса активации. 

Если письмо не создается,  просто пришлите нам серийный номер (регкод)  программы и 
HardwareID компьютера, на котором установлена программа.  

¡ Вы получите на ящик,  с которого посылали запрос,  ответ с вложенным файлом с 
расширением .lic (Chameleon.lic).  

¡ Перенесите этот файл на компьютер,  на котором хотите зарегистрировать программу (не 
подключенный к Интернет)  и   с о х р ани т е   в   п а п к у  AKVIS в  Общих документах
пользователей (см выше).  

  

  

AKVIS Chameleon

 11 / 82

http://akvis.com/ru/support/feedback.php?ref=help


СОЗДАНИЕ КОЛЛАЖЕЙ 

AKVIS Chameleon — программа для создания коллажей и фотомонтажей.  

   

 
Home  

(Plugin)
Home  

(Standalone)
Home Deluxe  

 (Plugin+Standalone) 
Business  

 (Plugin+Standalone) 

Назначение 

 
некоммерческое 
использование   

 
коммерческое 
использование  

Редакция (Edition) 

  Plugin  

  Standalone  

Возможности 

  Режим "Фотомонтаж"
    

  Режим "Хамелеон"
    

  Режим "Смешивание"
    

  Режим "Встраивание"
    

 
Импорт/экспорт: 

    *.chameleonFragment

  Печать 
   

Цветовое пространство 

  RGB
   

  CMYK 

  Lab 

  Grayscale 

  8 / 16 bits 

  32 bits 
    

Формат 

  TIFF 

  JPEG 

  BMP 

  PNG 

  RAW 
   

  PSD 
   

OS 
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  Windows-версия 

  Macintosh-версия 

10-дн. пробный период 

Цена  75 y.e. 75 y.e. 90 y.e. 230 y.e. 
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ 

  

AKVIS Chameleon может работать как отдельная программа или как плагин к графическому 
редактору.  

Для вызова плагина AKVIS Chameleon необходимо выполнить следующее:  

¡ В редакторе открыть изображение,  фрагмент которого будет использован для создания 
коллажа.  

¡ С помощью Инструментов выделения выделить нужный фрагмент и в меню фильтров 
графического редактора выбрать пункт Chameleon - Grab Fragment. 

В редакторе Adobe Photoshop: Filter –> AKVIS –> Chameleon – Grab Fragment; в Paint Shop 
Pro: Effects –> Plugins -> AKVIS –> Chameleon – Grab Fragment; в программе Corel Photo-
Paint: Effects –> AKVIS –> Chameleon – Grab Fragment.  

При этом на экран будет выведено сообщение, что выделенный фрагмент сохранен в буфер. 

¡ Открыть в редакторе изображение,  которое будет использоваться в качестве фона для 
коллажа, и выбрать пункт Chameleon - Make Collage из меню фильтров. 

В редакторе Adobe Photoshop: Filter –> AKVIS –> Chameleon – Make Collage; в Paint Shop 
Pro: Effects –> Plugins -> AKVIS –> Chameleon – Make Collage; в программе Corel Photo-
Paint: Effects –> AKVIS –> Chameleon – Make Collage.  

Запустить отдельную программу AKVIS Chameleon можно следующими способами:  

¡ На компьютере с Windows: 

- Через главное меню:  нажать на кнопку Пуск (Start) и,  передвигаясь по системе 
открывающихся меню, мышью выбрать пункт AKVIS – Chameleon.  

- С помощью ярлыка программы на Рабочем столе:  поместить курсор на иконку 
программы AKVIS Chameleon и дважды щелкнуть левой кнопкой мыши.  

¡ На компьютере с Macintosh: 

- через Finder:  на боковой панели окна Finder найти папку Applications, в ней выбрать 
приложение AKVIS Chameleon и дважды щелкнуть по нему.  

Окно программы AKVIS Chameleon выглядит следующим образом:  

AKVIS Chameleon
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Рабочая область AKVIS С hameleon  

Элементы окна программы:  

Большую часть окна программы AKVIS Сhameleon занимает Окно изображения  с  двумя 
закладками До (Before) и  После (After). В закладке До выводится фоновое изображение,  а 
поверх него изображение,  содержащее нужный фрагмент.  Для отдельной программы это всегда 
будет целое изображение.  В плагин же будет передано выделение,  выполненное в графическом 
редакторе,  если таковое имеется,  с возможностью откорректировать его в данной закладке.  В 
закладке После выводится получившийся коллаж.  

   

В верхней части окна расположена Панель управления.  По умолчанию можно сворачивать и 
разворачивать панель щелчком по маленькой треугольной стрелке.  Свёрнутая панель всплывает 
при наведении курсора. Чек-бокс Закрепить панель управления (Lock the Control Panel) в окне 
Настройки позволяет зафиксировать Панель управления.  

¡ Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Chameleon. 

 

¡ Кнопка   (только в отдельной программе)  предназначена для открытия изображения, 

которое будет использоваться в качестве фона.  Для открытия фонового изображения 
можно также использовать сочетание клавиш Ctrl+O  ( +O  на Macintosh).  

¡ Кнопка   предназначена для открытия изображения,  с которого будет вырезаться 

фрагмент.  

¡ Кнопка   (только в отдельной программе)  предназначена для сохранения на диск 

результирующего изображения.  Для сохранения изображения можно также использовать 
сочетание клавиш Ctrl+S  ( +S  на Macintosh).  

¡ Кнопка   (только в отдельной программе)  предназначена для вывода изображения на 

печать.  Для вызова диалога печати изображения можно также использовать сочетание 
клавиш Ctrl+P  ( +P  на Macintosh).  

AKVIS Chameleon
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¡ Кнопка   предназначена для открытия файлов с расширением .chameleonFragment. В 

файл с таким расширением можно сохранять фрагмент,  использовавшийся для создания 
коллажа.  При этом запоминается положение фрагмента относительно фонового 
изображения, ограничивающие контуры и параметры на Панели настроек.  

¡ Кнопка   предназначена для сохранения фрагмента,  участвующего в создании 

коллажа,  с о   в с е м и   е г о   п а р а м е т р а м и   в   о т д е л ь н ы й   ф а й л   с  
расширением .chameleonFragment.  

¡ Кнопка   предназначена для отмены последнего действия.  Если нажать на эту кнопку 

несколько раз,  то будут отменены несколько последних действий.  Отменить действие 
можно с клавиатуры, используя комбинацию клавиш Ctrl+Z  ( +Z  на Macintosh).  

¡ Кнопка   позволяет восстановить (повторить)  действие,  отмененное командой  . 

Восстановить отмененное действие можно с клавиатуры комбинацией клавиш Ctrl+Y  (

+Y  на Macintosh).  

¡ Кнопка   запускает процесс создания коллажа.  Запустить процесс можно с клавиатуры 

сочетанием клавиш Ctrl+R .  

¡ Кнопка   (только в плагине)  позволяет передать полученный коллаж в графический 

редактор и закрыть окно плагина AKVIS Chameleon.  

¡ Кнопка   предназначена для вызова сведений о программе. 
 

¡ Кнопка   (либо клавиша F1 ) предназначена для вызова справки помощи по программе. 
 

¡ Кнопка   вызывает диалог изменения Настроек программы. 
 

   

Сле в а   о т  Окна изображения находится  Панель инструментов.  Параметры выбранного 
инструмента отображаются на Панели настроек.  Подробнее о каждом инструменте можно 
прочитать здесь.  

   

Перемещение по изображению и масштабирование осуществляется с помощью Окна навигации. 
Рамкой в Окне навигации отмечается та часть изображения, которая в данный момент является 
видимой в Окне изображения;  области за пределами рамки будут затенены.  Рамку можно 
перетаскивать,  меняя тем самым видимую часть изображения.  Для перемещения рамки 
необходимо поместить курсор внутрь рамки и,  удерживая левую кнопку мыши,  выполнить 
перетаскивание.  

  
Окно навигации  

Кроме того,  для прокрутки изображения в Окне изображения можно использовать полосы 
прокрутки или нажать на пробел и перетаскивать изображение левой кнопкой мыши.  Прокруткой 
колёсика мыши изображение можно перемещать вверх-вниз,  удерживая Ctrl  (  на Macintosh) –

AKVIS Chameleon

 16 / 82



вправо-влево,  удерживая Alt  (Option  на  Macintosh) − масштабировать.  При щелчке правой 
кнопкой мыши на полосе прокрутки появляется меню быстрых перемещений.  

С помощью кнопок   и   ,  а также с помощью ползунка можно масштабировать изображение в 
Окне изображения.  При щелчке на кнопке   или при перемещении ползунка вправо происходит 
увеличение масштаба изображения.  А при щелчке на кнопке   или при перемещении ползунка 
влево происходит уменьшение масштаба изображения.  

Также масштаб изображения можно изменить,  если ввести в поле масштабирования новый 
масштабный коэффициент и нажать клавишу Enter  (Return  на Macintosh). Часто используемые 
масштабы помещены в выпадающее меню поля масштабирования. 

Кроме того,  для изменения масштаба изображения можно воспользоваться клавиатурными 
сокращениями:  +  и  Ctrl++  ( ++  на Macintosh) для увеличения масштаба изображения,  -  и 
Ctrl+-  ( +-  на Macintosh) для уменьшения масштаба. 

  

Под Окном навигации расположена Панель настроек,  на которой выбирается режим создания 
коллажа и задаются настройки для выбранного режима.  

Ниже Панели настроек выводится Подсказка:  краткое описание параметров и кнопок,  на 
которые наводится курсор.  Изменить местоположение и оформление окна подсказки можно в 
Настройках программы.  
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РАБОТА С ПРОГРАММОЙ 

  

Для того чтобы создать коллаж с помощью программы AKVIS Chameleon, необходимо выполнить 
следующие действия:  

¡ Шаг 1. Запустить отдельную программу AKVIS Chameleon или графический редактор, если 
вы хотите работать с плагином AKVIS Chameleon.  

¡ Шаг 2. Открыть два изображения.  Одно - использующееся в качестве фона для коллажа, 
второе - содержащее в себе фрагмент, который будет частью коллажа. 

- При работе с плагином:  

В графическом редакторе с помощью команды меню Файл -> Открыть (File -> Open) или 
сочетания клавиш Ctrl+O  вызвать диалог открытия изображения и выбрать требуемые 
файлы. 

- В отдельной программе (файл в формате TIFF, BMP, JPEG или PNG):  

Диалоговое окно Открыть изображение можно вызвать сразу после запуска программы с 
помощью двойного щелчка мыши в области Окна изображения или кнопками на Панели 

управления:  кнопка   - для открытия фонового изображения;  кнопка   - для 

открытия изображения, у которого будет использован только фрагмент.  
 

Вид изображений, открытых в отдельной программе  

Кроме того,  можно перетащить ярлык изображения в открытое окно программы (только 
фоновое изображение) или редактора.  

¡ Шаг 3. Только при работе с плагином.  Выделить нужный фрагмент на соответствующем 
изображении с помощью любого из Инструментов выделения графического редактора. 

 

Фоновое изображение  Изображение, с которого 
берется фрагмент 
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¡ Шаг 4. Только при работе с плагином. В меню фильтров графического редактора выбрать 
пункт AKVIS -> Chameleon – Grab Fragment. 

В редакторе Adobe Photoshop: Filter –> AKVIS –> Chameleon – Grab Fragment; в Paint Shop 
Pro: Effects –> Plugins -> AKVIS –> Chameleon – Grab Fragment; в программе Corel Photo-
Paint: Effects –> AKVIS –> Chameleon – Grab Fragment.  

Если действия выполнены корректно, на экран будет выведено сообщение, что выделенный 
фрагмент сохранен в буфер.  

¡ Шаг 5. Только при работе с плагином.  Переключиться на изображение,  которое будет 
использоваться в качестве фона для коллажа. 

Обратите внимание,  что результат применится сразу же к выбранному слою в 
графическом редакторе.  Если вы хотите сохранить исходный слой,  сделайте копию 
слоя перед вызовом плагина.  

Теперь нужно выбрать пункт AKVIS –> Сhameleon – Make Collage из меню фильтров.  

В редакторе Adobe Photoshop: Filter –> AKVIS –> Chameleon – Make Collage; в Paint Shop 
Pro: Effects –> Plugins -> AKVIS –> Chameleon – Make Collage; в программе Corel Photo-
Paint: Effects –> AKVIS –> Chameleon – Make Collage.  

После совершения вышеперечисленных действий откроется окно программы AKVIS 
Chameleon, в Окне изображения которого будет показано фоновое изображение и поверх 
него - выделенный ранее объект.  

 

Вид изображений в плагине  

Примечание: Несмотря на то,  что при открытии окна плагина выделение передается из 
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¡ Шаг 6. Выбрать один из четырех режимов создания коллажа (Фотомонтаж/Montage, 
Хамелеон/Chameleon,  Смешивание/Blend Mode,  Встраивание/Emersion) ,  щелкнув 
левой кнопкой мыши на соответствующем пункте в выпадающем списке на Панели 
настроек. 

¡ Режим Фотомонтаж.  Режим Фотомонтаж предназначен для создания коллажей в их 
классическом понимании.  То есть основная часть вставленного фрагмента не 
изменяется,  а края фрагмента сглаживаются и изменяют цвет и прозрачность, 
подстраиваясь под фоновое изображение.  

¡ Р е ж и м  Хамелеон.  В   р е ж и м е  Хамелеон вставленный фрагмент полностью 
адаптируется под фоновое изображение: сглаживаются края и изменяется цвет всего 
фрагмента, подстраиваясь под окружающие его цвета фонового изображения.  

¡ Режим Смешивание.  Режим Смешивание отличается от режима Хамелеон тем,  что 
сквозь вставленный фрагмент просвечивает рисунок и текстура самого фонового 
изображения.  Этот режим идеально подходит в том случае,  когда объект необходимо 
«растворить» в фоновом изображении.  

¡ Режим Встраивание. Режим Встраивание, как и режим Фотомонтаж, предназначен 
для реалистичного совмещения изображений.  Отличие состоит в том,  что в режиме 
Встраивание выделенный объект не накладывается поверх фона, а «встраивается» в 
фон отдельными областями,  благодаря чему в некоторых случаях можно добиться 
совмещения более сложных по форме объектов. 

графического редактора,  при   н еобходимо с ти   е г о   т а кже  можно  
отредактировать с помощью инструментов в самом плагине. 

Примечание: Если при работе с плагином пропустить шаги 3  и  4 ,  то поверх фонового 
изображения будет вставлен фрагмент,  который использовался при 
последней работе с программой AKVIS Chameleon. 

Внимание! В режиме Встраивание обязательным условием является точное 
выделение объекта. 

Режим "Фотомонтаж" Режим "Хамелеон"
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¡ Шаг 7. С помощью инструмента Трансформация (кнопка   на Панели инструментов) 

изменить размеры, угол поворота и положение объекта на фоновом изображении. 
 

При нажатии на кнопку   (клавиша T )  вокруг объекта появится пунктирная рамка,  а на 
Панели настроек будут показаны параметры трансформации.  

Для изменения размера объекта нужно подвести курсор мыши к рамке так,  чтобы 
появилась двусторонняя стрелка  ,  и,  щелкнув и удерживая левую кнопку мыши, 
увеличить или уменьшить фрагмент.  Кроме того,  отмасштабировать изображение можно, 
вручную изменив значения параметров трансформации Ш - Ширина и В - Высота.  

Между параметрами Ш  и  В расположен значок связи  / .  При включенном значке 

фрагмент будет отмасштабирован пропорционально,  при отключенном   можно задать 
параметрам масштабирования любые значения. При отрицательных значениях параметров Ш
и  В изображение зеркалируется в горизонтальном и вертикальном направлениях 
соответственно.  

Для поворота объекта необходимо подвести курсор мыши к угловому маркеру так,  чтобы 

курсор мыши принял форму закругленной двойной стрелки  ,  нажать на левую кнопку 
мыши и,  продолжая удерживать кнопку нажатой,  перетащить курсор.  Также повернуть 
объект можно, задав на Панели настроек значение для параметра У - Угол в градусах от 
0 до 360.  

Для перемещения объекта достаточно поместить курсор внутрь рамки,  чтобы курсор 
приобрел форму перпендикулярных двусторонних стрелок  ,  нажать на левую кнопку 
мыши и, продолжая удерживать кнопку нажатой, передвинуть курсор.  

¡ Шаг 8. Для более точного расположения выбранного фрагмента можно воспользоваться 
параметром Непрозрачность,  который управляет прозрачностью вставленного фрагмента 

Режим "Смешивание" Режим "Встраивание"
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и принимает значения 0%, 25%, 50%, 75%, 100%. При значении параметра 100% фрагмент 
абсолютно непрозрачен.  При меньших значениях сквозь фрагмент начинает просвечивать 
фоновое изображение.  Особенно это полезно при работе с портретами или композициями, 
когда требуется аккуратно вставить объект в нужное место. 

 

Непрозрачность = 5 0 % 

¡ Шаг 9. С помощью инструментов, представленных ниже,  выделить фрагмент для коллажа и 
отметить ненужные области на изображении: 

¡ Взять фрагмент .  Синим контуром на изображении обводятся объекты и области, 
которые не должны измениться при создании коллажа.  Активировать инструмент с 
клавиатуры можно, нажав на клавишу K .  

¡ Удалить фрагмент .  Красным контуром на изображении отмечаются объекты и 
области,  которые должны адаптироваться под фоновое изображение.  Активировать 
инструмент с клавиатуры можно, нажав на клавишу D .  

¡ Ластик . С помощью данного инструмента можно частично или полностью стереть 
нарисованные контуры.  Активировать инструмент Ластик с клавиатуры можно, нажав 
на клавишу E .  

 

 

Для того чтобы нарисовать контур,  нужно выбрать инструмент   или  , затем щелкнуть 
левой кнопкой мыши в нужной точке фрагмента и,  удерживая кнопку,  начать проводить 
линию. Для получения прямых линий при рисовании удерживайте клавишу Shift .  

Примечание: Параметр Непрозрачность является вспомогательным: он нужен только для 
удобства создания коллажа и не влияет на окончательный результат. 

AKVIS Chameleon

 22 / 82



Для того чтобы стереть контур,  нужно выбрать инструмент Ластик ,  подвести курсор 
мыши к ненужному контуру и,  щелкнув и удерживая левую кнопку мыши,  вести курсор 
вдоль контура, чтобы последний исчез.  

Ластик можно увеличить или уменьшить, изменив параметр Размер Ластика.  

¡ Шаг 10. Нажать на кнопку   для запуска процесса создания коллажа.  Результат будет 

показан в закладке После. 

При не совсем удачном результате необходимо переключиться на закладку До  и  

нарисовать контуры более точно, а затем снова нажать на кнопку  .  

¡ Шаг 11. Можно сохранить фрагмент,  подготовленный для создания коллажа,  чтобы потом 
продолжить работу с ним. 

Для этого необходимо нажать на кнопку   на Панели управления и в диалоговом окне 

Сохранить фрагмент ввести имя файла и выбрать нужную папку.  

Фрагмент будет сохранен в файл с расширением .chameleonFragment.  При этом 
запоминаются положение фрагмента относительно фонового изображения, ограничивающие 
контуры и параметры на Панели настроек.  

Открыть ранее сохраненный фрагмент можно,  нажав на кнопку   и выбрав нужный 

фрагмент в диалоговом окне Открыть фрагмент.  

¡ Шаг 12. Только при работе с плагином:  нажать на кнопку   для применения 

результатов и закрытия окна плагина.  

¡ Шаг 13. Сохранить получившееся изображение. 

- При работе с плагином:  

В графическом редакторе вызвать диалог сохранения файла командой меню Файл -> 
Сохранить как (File -> Save As), ввести имя файла,  указать формат и выбрать каталог,  в 
который необходимо сохранить файл.  

- В отдельной программе:  

Нажать на кнопку   и в диалоговом окне Сохранить изображение ввести имя файла, 

указать формат (TIFF, BMP, JPEG или PNG) и выбрать каталог,  в который необходимо 
сохранить файл.  

¡ Ш а г  14. В стандалон-версии  AKVIS Chameleon есть возможность распечатать

получившееся изображение.  Для этого необходимо нажать на кнопку  ,  в диалоговом 

окне Печать (Print Image) задать параметры печати,  а затем нажать на кнопку Печать
(Print).  

¡ Шаг 15. Выйти из программы AKVIS Chameleon.  

  

AKVIS Chameleon

 23 / 82



НАСТРОЙКИ ПРОГРАММЫ 

  

Диалог изменения настроек программы имеет вид:  

  

¡ Язык программы (Language). Для переключения интерфейса программы на другой язык 
необходимо выбрать язык из выпадающего списка.  

¡ Масштаб изображения при загрузке (Initial Scale). Параметр определяет способ 
отображения изображения в окне программы при его открытии.  Принимает одно из двух 
значений: 

- изображение масштабируется Под размер окна (Fit to View). Масштаб подбирается 
так, чтобы оно было полностью видимым в Окне изображения (Image Window);  

- при значении параметра 100% изображение не масштабируется.  В большинстве 
случаев при открытии в масштабе 100% в окне программы будет показана лишь часть 
изображения.  

¡ Отображение подсказок (Hints Panel). В данном блоке задаётся местоположение и стиль 
оформления окна подсказок. 

¡ Опция Расположение (Position) позволяет указать место вывода подсказок. 

- Слева под окном изображения (Under Image Window);  
- Справа на панели настроек (Under Settings Panel);  
- Не отображать (Hide); 

¡ Опция Оформление (Color) изменяет внешний вид текстовой подсказки. 

- Серая панель (Gray Panel);  
- Жёлтая панель (Yellow Panel); 

¡ Последние открытые файлы (Recent Files). Количество файлов,  отображаемых в списке 
недавно открытых документов (сортированы по времени открытия). Правым кликом мыши по 

кнопке   вызывается список фоновых изображений,  по  кнопке    - список 

изображений с фрагментами для коллажа. Максимальная длина списка - 30 файлов.  

¡ Чек-бокс Системный диалог открытия/сохранения (Use OS File Dialog). При включенном 
чек-боксе для открытия/сохранения файлов используются диалоги операционной системы, 
при неактивном - программные диалоги.  

¡ Чек-бокс Закрепить панель управления (Lock the Control Panel) блокирует возможность 
сворачивания панели.  

¡ Чек-б о к с  Использовaт ь  GPU ( U s e  G P U )  позволяет ускорить вычисления за счёт 
использования графического процессора.  

Для принятия изменений в окне Настройки (Preferences) нажмите ОК.  
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При необходимости можно вернуть исходные значения параметров,  нажав на кнопку По 
умолчанию (Default).  
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ 

  

Программа AKVIS Chameleon позволяет распечатать получившееся изображение.  Диалоговое 
окно Печать появляется после нажатия на кнопку  .  

  

¡ Принтер (Printer). Если компьютер подключен к локальной сети с несколькими принтерами 
или к самому компьютеру подключено более одного устройства вывода,  то перед началом 
печати в выпадающем списке принтеров требуется указать нужный.  Выбрать Разрешение
(Print Resolution), доступное данной модели принтера.  

¡ Ориентация (Orientation) бумаги при печати.  Существует два типа задания ориентации -
Альбомная (Album) и  Портретная (Portrait). Альбомная соответствует горизонтальному 
положению листа (ширина больше высоты), а Портретная – вертикальному.  

¡ Размер при печати (Print Size). Размер изображения при выводе на печать задают 
параметры Масштаб (Scale), Ширина (Width), Высота (Height) и Подогнать под размер 
страницы (Fit to Page). Они не влияют на само изображение,  а только на его печатную 
копию.  Изменить размер печатной копии можно либо указав масштаб изображения в % 
(любые значения меньше 100% приведут к уменьшению размера,  а любые значения больше 
100% - к увеличению) ,  либо указав новые значения ширины и высоты в полях ввода 
Ширина  и  Высота.  Если требуется автоматически подогнать изображение под размер 
страницы, достаточно отметить пункт Подогнать под размер страницы.  

¡ Положение (Move To). Положение изображения на странице можно сместить относительно 
центра, щелкнув на одной из восьми стрелок. 

Изменить размер изображения при печати и его положение на странице также можно 
вручную.  В области предварительного просмотра вокруг изображения отображается рамка 
с маркерами.  Для изменения размера изображения необходимо подвести курсор мыши к 
угловому маркеру или стороне рамки (курсор изменит свою форму на двустороннюю 
стрелку)  и перетащить маркер или сторону.  Для того чтобы изменить положение 
изображения на странице,  нужно подвести курсор внутрь изображения,  нажать на левую 
кнопку мыши и переместить курсор.  

При нажатии на кнопку Параметры страницы (Page Setup) открывается соответствующее 
диалоговое окно,  в котором можно выбрать размер и ориентацию бумаги при печати,  а также 
задать поля печати.  Для печати изображения с учетом настроенных параметров нажать на 
кнопку Печать (Print). Для отмены печати и закрытия окна печати нажать на кнопку Отмена.  
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РЕЖИМ "ФОТОМОНТАЖ" (MONTAGE MODE) 

  

Программа AKVIS Chameleon предлагает четыре режима создания коллажей:  Фотомонтаж, 
Хамелеон, Смешивание и Встраивание.  

Режим Фотомонтаж предназначен для реалистичного совмещения изображений и создания 
иллюзии целостного фото.  Основная часть вставленного фрагмента не изменяется,  а края 
фрагмента сглаживаются и изменяют цвет и прозрачность,  подстраиваясь под фоновое 
изображение.  

   

Посмотрите обучающий ролик,  в котором показано,  как создавать коллажи с помощью режима 
Фотомонтаж плагина Chameleon: 
нажмите здесь для запуска ролика (flash-ролик, 4.14 Mb).  

  

Для создания коллажа в режиме Фотомонтаж необходимо выполнить следующие действия:  

¡ Шаг 1. Нажмите кнопку   для открытия фонового изображения, а затем кнопку   для 

открытия изображения, у которого будет использован только фрагмент. 

 

 

Исходные изображения Результат
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Внимание: Если вы работаете с плагином, выполните следующие шаги (шаги 3-5).  

¡ Шаг 2. С помощью инструмента Трансформация (кнопка   на Панели инструментов) 

изменить размеры, угол поворота и положение объекта на фоновом изображении. 

Для более точного расположения выбранного фрагмента можно воспользоваться 
параметром Непрозрачность.  

 

¡ Шаг 3. Отредактировать контуры с помощью следующих инструментов: 

¡ Инструмент Взять фрагмент (кнопка  ) .  Синим контуром на изображении 
обводятся объекты и области,  которые не должны измениться при создании коллажа. 
Активировать инструмент с клавиатуры можно, нажав на клавишу K .  
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¡ Инструмент Удалить фрагмент (кнопка  ) .  Красным контуром на изображении 
отмечаются объекты и области,  которые должны адаптироваться под фоновое 
изображение. Активировать инструмент с клавиатуры можно, нажав на клавишу D .  

¡ Инструмент Ластик (кнопка  ) .  С помощью данного инструмента можно частично 
или полностью стереть нарисованные контуры.  Активировать инструмент Ластик  с  
клавиатуры можно, нажав на клавишу E .  

 

¡ Шаг 4. Нажать на кнопку   для запуска процесса создания коллажа.

Результат будет показан в закладке После.  
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Если результат не устраивает, можно переключиться на закладку До и нарисовать контуры 

более точно, а затем снова запустить процесс обработки, нажав на кнопку  .  
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ФОТООХОТА 

  

Пример выполнен в графическом редакторе Adobe Photoshop, но выполнить его можно в любом 
другом редакторе, с которым совместим плагин AKVIS Chameleon. 

¡ Шаг 1. Откроем в редакторе изображение, с которого возьмем фрагмент. 

 

 

¡ Шаг 2. Выделим фрагмент. 

 

 

В основном меню выберем пункт Filter –>  AKVIS –>  Chameleon – Grab Fragment.  На 
экран будет выведено сообщение, что фрагмент сохранен  

¡ Шаг 3. Откроем фоновое изображение. 
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¡ Шаг 4. В меню выберем пункт Filter –> AKVIS –> Chameleon – Make Collage.  Откроется 
окно плагина AKVIS Chameleon,  в закладке До (Before) которого будет показано фоновое 
изображение, а поверх него – скопированный фрагмент. 

 

 

По умолчанию выбран режим Фотомонтаж (Montage). В нем и будем продолжать работу.  

¡ Шаг 5. Н а  Панели инструментов плагина выберем инструмент Трансформация  и  
«посадим» мальчика в нужное место. 
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¡ Шаг 6. Теперь нужно избавиться от фона, оставшегося от исходного изображения. 

Сначала на Панели инструментов выберем инструмент Удалить фрагмент и нарисуем 
контур вокруг мальчика.  Затем выберем инструмент Взять фрагмент и нарисуем контур 
внутри изображения мальчика, чтобы оно не стерлось вместе с фоном.  

 

 

¡ Шаг 7. Нажмем кнопку  ,  чтобы запустить процесс создания коллажа.  Результат будет 

показан в закладке После (After). 
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¡ Шаг 8. Нажмем  .  При этом окно плагина AKVIS Chameleon закроется,  а в окне 

редактора появится наш коллаж. 

 

 

¡ Шаг 9. Для большей реалистичности нарисуем траву:  на панели инструментов редактора 
выберем инструмент Кисть,  подберем нужный размер и цвет и проведем несколько 
штрихов. Выберем другой цвет и проведем еще несколько штрихов. Трава готова: 
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А вот и окончательный результат:  

 

 

Вряд ли мальчик, выходя из дома, догадывался, что окажется в Африке.  
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РЕЖИМ "ХАМЕЛЕОН" (CHAMELEON MODE) 

  

Программа AKVIS Chameleon предлагает четыре режима создания коллажей:  Фотомонтаж, 
Хамелеон, Смешивание и Встраивание.  

В режиме Хамелеон вставленный фрагмент полностью адаптируется под фоновое изображение: 
сглаживаются края и изменяется цвет всего фрагмента,  подстраиваясь под окружающие его 
цвета фонового изображения.  

   

Для создания коллажа в режиме Хамелеон необходимо выполнить следующие действия:  

¡ Шаг 1. Нажмите кнопку   для открытия фонового изображения, а затем кнопку   для 

открытия изображения, у которого будет использован только фрагмент. 

 

 

Исходные изображения Результат
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Внимание: Если вы работаете с плагином, выполните следующие шаги (шаги 3-5).  

¡ Шаг 2. По умолчанию выбран режим Фотомонтаж/Montage.  Для перехода в режим 
Хамелеон/Chameleon выбрать соответствующий пункт в выпадающем списке на Панели 
настроек. 

 

 

¡ Шаг 3. С помощью инструмента Трансформация (кнопка   на Панели инструментов) 

изменить размеры, угол поворота и положение объекта на фоновом изображении. 

Для более точного расположения выбранного фрагмента можно воспользоваться 
параметром Непрозрачность.  
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¡ Шаг 4. Отредактировать контуры с помощью инструментов  ,  и  . 

 

 

¡ Шаг 5. При неточном выделении можно воспользоваться параметром Плавный переход. 
Данный параметр работает только при наличии на  изображении штрихов.  При 
отключенном параметре сглаживание границ происходит только вдоль красных контуров. 
При его активации сглаживание будет происходить на всей области,  заключенной между 
красными и синими штрихами. Чем дальше друг от друга находятся красные и синие штрихи, 
тем более постепенным, плавным будет переход на данных участках. 

AKVIS Chameleon

 38 / 82



¡ Шаг 6. Нажать на кнопку   для запуска процесса создания коллажа.  Результат будет 

показан в закладке После. 
 

Случай, когда штрихи находятся далеко друг от друга 

Параметр Плавный переход отключен Параметр Плавный переход включен

Примечание: Параметр следует использовать аккуратно.  Если на фрагменте присутствуют 
мелкие выступающие детали,  при активном параметре после обработки они 
могут быть размыты. 
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УПЛЫТЬ ЗА ЗАКАТ 

  

В данном примере покажем,  как в редакторе Adobe Photoshop с применением программы AKVIS 
Chameleon перенести яхты с первого изображения на второе изображение с закатом солнца. 

   

Итак, для того, чтобы перенести объект с одного изображения на другое необходимо:  

¡ Шаг 1. Выделить объект,  который требуется перенести. В данном случае для более точного 
и простого выделения яхты выделялись в режиме Quick Mask. 

 

 

¡ Шаг 2. Скопировать выделенное:  в основном меню выбрать пункт Filter –>  AKVIS –> 
Chameleon – Grab Fragment.  Если действия выполнены корректно,  на экран будет 
выведено сообщение, что выделенный фрагмент сохранен в буфер.  

¡ Шаг 3. Перейти на изображение заката, щелкнув на нем левой кнопкой мыши.  

¡ Шаг 4. В основном меню выбрать пункт Filter –> AKVIS –> Chameleon – Make Collage.  

¡ Шаг 5. Откроется окно плагина AKVUS Chameleon,  в Окне изображения которого будет 
показано фоновое изображение заката и поверх него выделенный ранее фрагмент с 

Исходные изображения Результат

показано фоновое изображение заката и поверх него выделенный ранее фрагмент с 
изображением яхт. 
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¡ Шаг 6. На Панели настроек выбрать из выпадающего списка режим Хамелеон.  

¡ Шаг 7. Отрегулировать местоположение объекта на новом изображении и его размер 
относительно нового пейзажа.  Для этого выбрать на Панели инструментов плагина 
инструмент   (клавиша T ). 

Для перемещения объекта достаточно поместить курсор внутрь рамки,  чтобы курсор 
приобрел форму перпендикулярных двухсторонних стрелок  ,  нажать левую кнопку мыши 
и, продолжая удерживать кнопку нажатой, передвинуть курсор.  

Для изменения размера объекта необходимо изменить значение параметров W и  H
инструмента Трансформация.  В данном случае значения для параметров W и  H были 
уменьшены со 100% до 60%.  

 

 

¡ Шаг 8. Нажать на кнопку   для запуска процесса обработки и подождать несколько 

секунд. Результат будет показан в закладке После (After).  

¡ Шаг 9. Нажать на кнопку   для принятия результата и выхода из плагина. 
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ГЛАЗА - ЗЕРКАЛО ДУШИ 

  

Как много могут сказать за человека глаза. Глаза могут передать настроение и чувства, характер 
и эмоции человека. При изменении выражения глаз меняется весь облик человека.  

Программа AKVIS Chameleon позволит вам изменить облик человека,  просто заменив его глаза на 
другие, взятые с любого другого изображения.  

Покажем,  как это сделать на следующем примере: голубые глаза девочки с первой фотографии 
мы заменим на карие глаза девушки со второй фотографии. 

¡ Шаг 1. Первым шагом на второй фотографии выделим глаза. 
 

¡ Шаг 2. Скопируем выделенную область:  выберем пункт AKVIS –>  Сhameleon – Grab 
Fragment из меню фильтров. 

В редакторе Adobe Photoshop - это пункт меню Filter –>  AKVIS –>  Chameleon – Grab 
Fragment; в Paint Shop Pro - Effects –> Plugins -> AKVIS –> Chameleon – Grab Fragment; а в 
программе Corel Photo-Paint - пункт меню Effects –> AKVIS –> Chameleon – Grab Fragment.  

¡ Шаг 3. Перейдем на первую фотографию.  В меню фильтров выберем пункт AKVIS –> 
Сhameleon – Make Collage. 

В редакторе Adobe Photoshop - это пункт меню Filter –> AKVIS –>  Chameleon – Make 
Collage; в  Paint Shop Pro - Effects –> Plugins -> AKVIS –> Chameleon – Make Collage; а в 
программе Corel Photo-Paint - пункт меню Effects –> AKVIS –> Chameleon – Make Collage.  

Откроется окно плагина AKVIS Chameleon,  в Окне изображения которого будет показано 

Исходные изображения Результат
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изображение девочки с голубыми глазами и поверх него выделенные ранее глаза второй 
девочки.  

¡ Шаг 4. Из выпадающего списка на Панели настроек выберем режим Хамелеон.  

¡ Шаг 5. С помощью инструмента Трансформация изменим положение и размер вставленной 
области так, чтоб глаза стали подходящими под «новое» лицо. 

 

¡ Шаг 6. Запустим программу AKVIS Chameleon, нажав на кнопку   и подождем несколько 

секунд. Результат будет показан в закладке После (After).  

¡ Шаг 7. Нажмем на кнопку   для принятия результата и выхода из плагина.  Вот что у 

нас получилось: 
 

Вы можете так же просто поменять и любую другую часть лица.  

  

AKVIS Chameleon

 44 / 82



ПРИМЕРКА ТАТУИРОВКИ 

  

   

¡ Шаг 1. Откроем в редакторе Adobe Photoshop изображение, на котором будем "примерять" 
татуировку, 

 

 

и фотографию с понравившейся татуировкой. 

 

 

¡ Шаг 2. С помощью инструмента Lasso выделим татуировку на фотографии,  а затем 
скопируем выделение,  выбрав в меню Filters команду AKVIS ->  Chameleon - Grab 
Fragment. 

 

Исходные изображения Результат
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http://akvis.com/img/examples/chameleon/tattoo/original-photo-girls.jpg


 

 

¡ Шаг 3. Выберем пункт меню Filters ->  AKVIS ->  Chameleon - Make Collage.  При этом 
откроется окно плагина AKVIS Chameleon,  в закладке До  (Before) которого будет 
показано фотография девушек, а поверх него - вырезанная татуировка. 

 

 

¡ Шаг 4. На Панели настроек выберем из списка режим Chameleon.  

¡ Шаг 5. На Панели инструментов выберем инструмент Трансформация и изменим размер 
и местоположение татуировки таким образом, чтобы она подошла одной из девушек. 
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¡ Шаг 6. Нажмем кнопку   для запуска процесса обработки.  Результат будет показан в 

закладке После (After). 

 

 

¡ Шаг 7. Нажмем кнопку   для принятия результата и возврата в редактор. 
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Шаги 3  - 7  выполним три раза,  чтобы "примерить"  татуировку каждой из девушек на 
фотографии.  
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РЕЖИМ "СМЕШИВАНИЕ" (BLEND MODE) 

  

Программа AKVIS Chameleon предлагает четыре режима создания коллажей:  Фотомонтаж, 
Хамелеон, Смешивание и Встраивание.  

В   р е ж и м е  Смешивание вставленный фрагмент полностью адаптируется под фоновое 
изображение:  сглаживаются края и изменяется цвет всего фрагмента,  подстраиваясь под 
окружающие его цвета фонового изображения,  а сквозь вставленный фрагмент просвечивает 
рисунок и текстура самого фонового изображения.  Этот режим идеально подходит в том случае, 
когда объект необходимо «растворить» в фоновом изображении. 

   

Для создания коллажа в режиме Смешивание необходимо выполнить следующие действия:  

¡ Шаг 1. Нажмите кнопку   для открытия фонового изображения, а затем кнопку   для 

открытия изображения, у которого будет использован только фрагмент. 

 

 

Исходные изображения Результат
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Внимание: Если вы работаете с плагином, выполните следующие шаги (шаги 3-5).  

¡ Шаг 2. По умолчанию выбран режим Фотомонтаж/Montage.  Для перехода в режим 
Смешивание/Blend mode выбрать соответствующий пункт в выпадающем списке на 
Панели настроек. 

¡ Шаг 3. С помощью инструмента Трансформация (кнопка   на Панели инструментов) 

изменить размеры, угол поворота и положение объекта на фоновом изображении.

Для более точного расположения выбранного фрагмента можно воспользоваться 
параметром Непрозрачность.  

 

 

¡ Шаг 4. Отредактировать контуры с помощью инструментов инструментов  ,  и  . 
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¡ Шаг 5. При неточном выделении можно воспользоваться параметром Плавный переход. 
Данный параметр работает только при наличии на  изображении штрихов.  При 
отключенном параметре сглаживание границ происходит только вдоль красных контуров. 
При его активации сглаживание будет происходить на всей области,  заключенной между 
красными и синими штрихами. Чем дальше друг от друга находятся красные и синие штрихи, 
тем более постепенным, плавным будет переход на данных участках. 

¡ Шаг 6. Нажать на кнопку   для запуска процесса создания коллажа.  Результат будет 

показан в закладке После. 
 

Примечание: Параметр следует использовать аккуратно.  Если на фрагменте присутствуют 
мелкие выступающие детали,  при активном параметре после обработки они 
могут быть размыты. 
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РИСУЕМ ПО ДЕРЕВУ 

  

В данном примере будет показано,  как достичь эффекта рисования на поверхности, обладающей 
цветом и фактурой (холсте, дереве, мятой бумаге).  

С AKVIS Chameleon сделать это очень просто.  

В качестве фона возьмём фотографию деревянной дощечки, а переносить на неё будем яблоко.  

Последовательность действий такова:  

¡ Шаг 1. Открыть оба изображения в редакторе Adobe Photoshop.  

¡ Шаг 2. Перейти в режим выделения Быстрой маски,  нажав на кнопку   c  Панели 
инструментов или клавишу Q . 

Выбрать инструмент Карандаш  (горячая клавиша B ). Выделить яблоко,  закрасив его 

карандашом.  

 

 

Вернуться в режим рисования Standard Mode,  нажав  на  кнопку    c  Панели 
инструментов или клавишу Q .  

¡ Шаг 3. Инвертировать выделение командой Inverse в  меню  Select или с помощью 
комбинации клавиш Ctrl+Shift+I . 

 

Исходные изображения Результат
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¡ Шаг 4. Скопировать выделенное изображение:  в основном меню выбрать пункт Filter –> 
AKVIS –> Chameleon – Grab Fragment.  

¡ Шаг 5. Переключиться в окно с фотографией деревянной поверхности,  которая послужит 
фоном для коллажа,  и в основном меню выбрать пункт Filter –> AKVIS –> Chameleon –
Make Collage. 

Откроется окно плагина AKVIS Chameleon,  содержащее фоновое изображение и 
выделенный ранее фрагмент с яблоком.  

¡ Шаг 6. На Панели настроек выбрать из выпадающего списка режим Смешивание. 

С помощью инструмента Трансформация  изменить размер и положение яблока. 
 

 

 

¡ Шаг 7. Нажать на кнопку   для запуска процесса обработки и подождать несколько 

секунд. Результат будет показан в закладке После.  

¡ Шаг 8. Применить результат обработки, нажав на кнопку  . 
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В результате получился симпатичный рисунок по дереву.  
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ОТКРЫТКА НА ДЕНЬ СВЯТОГО ВАЛЕНТИНА 

  

В данном примере мы покажем вам,  как можно очень быстро сделать открытку своими руками. 
Например,  валентинку для любимого.  С помощью программы для создания коллажей AKVIS 
Chameleon это несложно,  а сам процесс созидания превращается в удовольствие.  Ваш подарок 
будет оригинальным и уникальным.  

  

Для этого нам понадобятся:  

¡ Adobe Photoshop (или другой графический редактор,  с которым совместим плагин AKVIS 
Chameleon),  

¡ плагин AKVIS Chameleon,  

¡ основное изображение для открытки (для нашей будущей "валентинки" идеально подойдет 
изображение с лепестками роз),  

¡ рисунок с готовой рамкой (мы выбрали изображение с ледяной рамкой)  

¡ и совсем немного времени.  

Итак, приступим к созданию открытки:  

¡ Шаг 1. Откроем в Adobe Photoshop те изображения,  из которых будет создаваться 
открытка. 

 

 

¡ Шаг 2. Соединим изображение лепестков с ледяной рамкой: 

¡ находясь на изображении с лепестками, выберем пункт меню Select - All;  

¡ скопируем выделение:  в основном меню выберем пункт Filter –>  AKVIS –> 
Chameleon – Grab Fragment;  

¡ перейдем на изображение с рамкой,  выполним команду Filter –>  AKVIS –> 
Chameleon – Make Collage.  Откроется окно плагина AKVIS Chameleon,  в закладке 
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До(Before) которого будет показано изображение ледяной рамки,  а поверх неё -
изображение с лепестками; 

 

 

¡ в списке Режим (Mode) на Панели настроек выберем режим Смешивание (Blend);  

¡ с помощью инструмента Трансформация   н а  Панели инструментов изменим 
размер изображения с лепестками так, чтобы оно полностью закрывало рамку; 

 

 

¡ запустим процесс обработки (кнопка  ). Результат будет показан в закладке После 

(After);  

¡ нажмем кнопку   для принятия изменений и возврата в редактор. 
 

В результате, на этом этапе будет получено следующее изображение:  
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¡ Шаг 3. Какая же открытка без поздравительной надписи?  Особенно валентинка.  Текст 
может быть любой,  но не забывайте,  что приятнее всего получить "персональное" 
поздравление. Мы же в нашем примере ограничимся общими фразами. 

Итак, добавление надписи на поздравительную открытку:  

¡ На Панели инструментов выберем инструмент Horizontal Type.  

¡ Затем зададим параметры для текста: шрифт Chiller, размер 150, Smooth, цвет текста 
красный (панель Option инструмента Horizontal Type).  

¡ Щелкнем в окне изображения и введем текст (к примеру: "I love you").  
Надпись будет создана на отдельном слое.  

 

 

¡ Добавим тексту эффекты.  Для этого,  находясь на слое с надписью,  применим 
эффекты слоя Outer Glow,  Inner Glow и  Satin,  выполнив команды Layer - Layer 
Style - Outer Glow, Layer - Layer Style - Inner Glow и Layer - Layer Style - Satin.  
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¡ Шаг 4. А теперь добавим сердечек,  чтобы сделать валентинку более романтичной.  Этот 
этап также не должен вызвать особых затруднений,  так как любой графический редактор 
предоставляет набор таких стандартных фигур. 

¡ На Панели инструментов выберем инструмент Custom Shape.  

¡ На панели Option в параметре Shape из доступных вариантов фигур выберем Heart 
Card.  

¡ Нарисуем сердце на новом слое.  

 

 

¡ Находясь на слое с сердцем,  применим эффекты слоя Drop Shadow,  Inner Shadow и 
Bevel and Emboss,  выполнив команды Layer - Layer Style - Drop Shadow,  Inner 
Glow и Bevel and Emboss.  
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¡ Слегка повернем сердце с помощью команды Edit - Free Transform.  

¡ Создадим дубликат слоя с сердцем, выполнив команду Layer - Duplicate Layer.  

¡ Переместим второе сердце чуть правее и повернем с помощью команды Edit - Free 
Transform.  

Осталось только подправить расположение надписи и сердечек на открытке — и 
валентинка готова! Для просмотра открытки в полном размере (во всей красе) нажмите на 
изображение.  
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РЕЖИМ "ВСТРАИВАНИЕ" (EMERSION MODE) 

  

Программа AKVIS Chameleon предлагает четыре режима создания коллажей:  Фотомонтаж, 
Хамелеон, Смешивание и Встраивание.  

Режим Встраивание соединяет два изображения особым образом, так что объект "встраивается" 
в фон отдельными областями,  благодаря чему в некоторых случаях можно добиться совмещения 
сложных по форме объектов. 

Данный режим кардинально отличается по принципу работы от трех других режимов.  Если в 
режимах Фотомонтаж,  Хамелеон и Смешивание работа ведется с объектом и именно он 
подвержен различным изменениям,  то в режиме Встраивание работа происходит в основном с 
фоном.  

Для создания коллажа в режиме Встраивание необходимо выполнить следующие действия:  

¡ Шаг 1. Нажмите кнопку   для открытия фонового изображения, а затем кнопку   для 

открытия изображения, у которого будет использован только фрагмент. 

Исходные изображения Результат
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Внимание: Если вы работаете с плагином, выполните следующие шаги (шаги 3-5).  

¡ Шаг 2. По умолчанию выбран режим Фотомонтаж/Montage.  Для перехода в режим 
Встраивание/Emersion mode выбрать соответствующий пункт в выпадающем списке на 
Панели настроек. 
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¡ Шаг 3. С помощью инструмента Трансформация (кнопка   на Панели инструментов) 

изменить размеры,  угол поворота и положение объекта отоносительно фонового 
изображения. 

Для более точного расположения выбранного фрагмента можно воспользоваться 
параметром Непрозрачность.  

 

 

¡ Шаг 4. В случае необходимости отредактировать контуры с помощью инструментов  , 

и  . 

¡ Шаг 5. Отметить области,  которые должны быть заменены областями фрагмента.  Области 
распределяются по цветам и регулируются следующими параметрами: 

¡ Поле Цвета (Colors). Поле включает в себя набор цветов,  которые будут учитываться 
при преобразовании изображения.  В процессе обработки все точки фонового 
изображения,  имеющие цвета,  совпадающие с цветами из набора и близкие к ним, 
будут заменены соответствующими им по расположению точками фрагмента,  который 
нужно "вживить" в фон. 

 

Пример набора цветов  

Набор цветов регулируется с помощью шести цветовых квадратов. По умолчанию все 
цветовые квадраты являются пустыми и не содержат цветов. В этом случае все точки 
фонового изображения останутся без изменений и в результате обработки мы 
получим исходное изображение фона.  

Внимание!Для этих двух изображений выделение не требуется совсем. Оно не имеет 
смысла, так как используемый фрагмент (в данном примере это облачное небо) 
после трансформации принимает размеры больше размеров фона и выходит за 
его границы. В большинстве же случаев, как, например, здесь, для данного 
режима требуется точное выделение встраиваемого объекта. 

AKVIS Chameleon

 63 / 82



Для добавления цвета в набор нужно щелкнуть левой кнопкой мыши по одному из 
квадратов (при этом курсор примет вид пипетки), поднести курсор к нужной точке 
изображения и повторно щелкнуть левой кнопкой мыши.  Квадрат из набора 
приобретет цвет точки с изображения.  

Заменить цвет квадрата можно повторным щелчком по нему левой кнопкой мыши и 
выбором на изображении другого цвета.  

Для удаления цвета из набора и очистки цветового квадрата щелкните по нему 
правой кнопкой мыши. Тогда квадрат вернется к состоянию по умолчанию.  

¡ Параметр Диапазон (Threshold). Параметр определяет точки (области) фона, которые 
будут заменены точками (областями)  фрагмента.  При минимальном значении 
параметра при обработке будут заменяться точки фонового изображения,  имеющие 
исключительно цвета из набора.  При увеличении параметра заменяться начнут не 
только точки,  цвета которых совпадают с цветами из набора,  но и точки,  имеющие 
похожие на них цвета.  Чем больше значение параметра,  тем больше точек фонового 
изображения будет заменено точками "встраиваемого" фрагмента,  тем большая часть 
фрагмента будет объединена с фоновым изображением.  

¡ Шаг 6. Нажать на кнопку   для запуска процесса создания коллажа.  Результат будет 

показан в закладке После. 

 

 

При не совсем удачном результате необходимо переключиться на закладку До,  изменить 

набор цветов и отрегулировать параметр Диапазон, а затем снова нажать на кнопку  .  

  

Внимание!На данном этапе вся работа происходит с фоновым изображением. 
Вставляемый на изображение фрагмент не подвергается никаким изменениям. 
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ЛЮБИТЕЛЯМ ГРАФФИТИ ПОСВЯЩАЕТСЯ... 

  

Граффити как вид творчества в его современном обличии появился во второй половине XX века, 
хотя берет начало в глубокой древности.  Спор о том,  что же такое граффити на сегодня –
искусство или вандализм,  как вопрос «что было раньше,  курица или яйцо?»,  так и не нашел 
ответа.  Благодаря сторонникам такого вида самовыражения в наше время граффити можно 
встретить везде,  где ступала нога человека,  но далеко не всегда оно бывает «к месту»,  ведь 
что-то из граффити действительно можно назвать произведениями искусства,  а   ч то-т о  –
обыкновенная порча гос. имущества и исторических и культурных памятников.  

В данном примере мы покажем,  как нарисовать граффити где угодно и при этом не быть 
оштрафованным за содеянное.  

Изображение,  используемое в примере,  - авторское.  К сожалению,  самого автора мы не знаем, 
так как рисунок взят из интернета, но надеемся, он на нас не обидится.  

Пример выполнен в графическом редакторе Adobe Photoshop, но выполнить его можно в любом 
другом редакторе, с которым совместим плагин AKVIS Chameleon. 

¡ Шаг  1. В графическом редакторе откроем изображение,  фрагмент которого будем 
использовать. 

 

 

¡ Шаг 2. Теперь фрагмент необходимо выделить как можно точнее.  В данном случае 
изображение имеет сложную форму,  но нарисовано на однотонном фоне,  поэтому для 
наиболее быстрого и точного выделения проще всего сначала удалить фон, оставив только 
рисунок. 

Удалять будем с помощью стандартного инструмента Photoshop Волшебный ластик (Magic 

Eraser Tool) .  Выберем его на Панели инструментов (Tools), щелкнем на фоне вокруг 
цыпленка и на участках между крыльями и перьями на голове цыпленка. Итак, фон удален.  
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Осталось выделить фрагмент.  Для быстрого выделения щелкнем по иконке слоя в окне 
Слои (Layers), удерживая клавишу Ctrl  (  на Macintosh).  

 

Окно "Слои"  

 

 

В основном меню выберем пункт Filter –>  AKVIS –>  Chameleon – Grab Fragment.  На 
экран будет выведено сообщение, что фрагмент сохранен в буфер.  

¡ Шаг 3. Откроем фоновое изображение.  В данном случае в качестве фона используем 
фотографию обычной кирпичной стены. 
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¡ Шаг 4. Выберем пункт меню Filter –>  AKVIS –>  Chameleon – Make Collage.  При этом 
откроется окно плагина Chameleon,  в  Окне изображения которого будет показано 
фоновое изображение стены,  а  поверх  него  - заранее скопированный фрагмент с 
изображением цыпленка. 

 

 

¡ Шаг 5. С помощью выпадающего списка на Панели настроек переключимся в режим 
Встраивание.  

¡ Шаг  6. Используя инструмент Трансформация ,  увеличим размер фрагмента и 
подберем для него нужное положение. 
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¡ Шаг 7. Выберем на изображении стены цвета,  которые будут заменены областями 
фрагмента. 

 

 

¡ Шаг 8. Нажмем на кнопку   для запуска процесса обработки. Вот что у нас получилось. 

 

 

¡ Шаг  9. Чтобы придать изображению максимум естественности,  подберем значение 
параметра Диапазон. В данном случае оптимальное значение находится в районе 50-60. 
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Кажется, получилось достаточно реалистично.  

Осталось применить результат. Нажмем на  ,  чтобы закрыть окно плагина с учетом всех 

изменений и вернуться в редактор.  

¡ Шаг 10. Чуть не забыли один нюанс.  В  Шаге 4 на фоновом изображении хорошо 
просматривается тень, которая наполовину стерлась после работы с плагином.  Необходимо 
ее вернуть.  Для этого используем инструмент Photoshop Затемнение (Burn Tool). Выберем 
данный инструмент на панели инструментов редактора и подберем параметры инструмента. 
Теперь левой кнопкой мыши щелкнем в начале участка,  на котором нужно восстановить 
тень,  и,  удерживая клавишу Shift  (чтобы получилась ровная прямая), в конце участка. 
Вот теперь всё: 

 

 

P. S.: В результате эксперимента ни одна стена не пострадала!  
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ПТИЦА В КЛЕТКЕ 

  

AKVIS Chameleon можно использовать не только для вставки объекта на новый фон,  но и для 
совмещения разноплановых объектов.  С этой целью обычно применяют режим Встраивание, 
который предназначен для "смещения"  объектов с переднего плана на задний и наоборот.  В 
примере показано,  как "встроить" птицу в фоновый рисунок,  чтобы она оказалась за прутьями 
клетки.  

¡ Шаг 1. Запустим программу AKVIS Chameleon и с помощью кнопки   откроем 

фотографию тёмной комнаты с клеткой - она послужит основой (фоном) для коллажа. 

 

 

¡ Шаг 2. Теперь откроем объект (кнопка  )  - заранее подготовленное изображение с 

удалённым фоном. 
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¡ Шаг 3. Выберем из выпадающего списка в верхней части Панели настроек режим 
Встраивание,  а затем с помощью инструмента Трансформация  изменим размеры и 
положение объекта на фоновой картинке. 

 

 

Птица находится перед клеткой  

¡ Шаг 4. Далее "подскажем" программе,  что тёмное пространство за золотистыми прутьями и 
есть та область,  куда следует поместить объект.  Щёлкнем вначале по пустому квадрату 
(курсор примет форму пипетки) ,  а затем на участке с проглядывающей стеной.  Квадрат 
заполнится указанным фоновым цветом. Можно задать до 6 уточняющих оттенков (в нашем 
случае это будут чёрные и тёмно-коричневые тона). 

 

AKVIS Chameleon

 71 / 82



 

¡ Шаг 5. Запустим расчёт кнопкой  .  Теперь видно,  что сама клетка осталась без 

изменения, а между прутьями разместились фрагменты объекта. 
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¡ Шаг 6. Параметр Диапазон позволяет управлять совмещением изображений.  Чем больше 
заданное значение,  тем большая часть вставляемого объекта будет видна из-за прутьев. 
Увеличим значение параметра до 40 и запустим перерасчёт. 

Результат показан на закладке После - получилось довольно реалистичное изображение.  
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ПРОГРАММЫ КОМПАНИИ АКВИС 

  

AKVIS ArtSuite — Эффекты и рамки для фотографий   

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий.  

ArtSuite содержит множество готовых шаблонов и богатую Библиотеку образцов и текстур и 
позволяет получить практически бесконечное количество вариантов эффектов. подробнее...  

 

  

AKVIS ArtWork — Имитация художественных стилей   

AKVIS ArtWork позволяет превратить обычную фотографию в картину маслом или акварелью, как 
будто написанную кистью художника,  создать изображение в стиле комикса,  рисунок пером, 
линогравюру.  

На ваших глазах из фотографии рождается настоящее произведение искусства! подробнее...  
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AKVIS Chameleon — Создание коллажей   

AKVIS Chameleon — программа для создания коллажей, реалистичных и фантастических.  

Chameleon экономит время и силы,  так как не требует точного выделения объектов, 
автоматически сглаживает границы и подбирает цветовую гамму "вставки"  к цветам фона. 
подробнее...  

 

  

AKVIS Coloriage — Раскрашивание изображений   

Программа для раскраски черно-белых фотографий и замены цвета на цветных изображениях.  
Coloriage прост и понятен,  как детская книжка-раскраска,  он превращает работу в игру. 
Несколькими штрихами обозначьте объекты для перекрашивания.  Программа сама распознает 
границы,  наложит указанные цвета,  учитывая освещенность,  игру теней,  складки на одежде. 
подробнее...  
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AKVIS Decorator — Замена текстуры и перекраска поверхности   

AKVIS Decorator позволяет изменять поверхность объекта.  
При наложении текстуры сохраняется объем,  рельеф,  изгибы,  складки,  тени исходного 
изображения.  С помощью программы Decorator можно не только накладывать текстуру,  изменять 
ее, но и подгружать свои текстуры, а также просто изменять цвет объекта. подробнее...  

 

  

AKVIS Enhancer — Фотокоррекция с усилением детализации   

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. 

Enhancer обеспечивает комплексную коррекцию каждой точки изображения без потери качества, 
позволяет исправить любую отдельную фотографию,  проявить детали в светлых и темных 
областях. подробнее...  

 

  

AKVIS HDRFactory — Расширение динамического диапазона   

AKVIS HDRFactory — программа для создания изображений с высоким динамическим диапазоном и 
для коррекции фотографий.  С помощью AKVIS HDRFactory можно получить и максимально 
приближенные к реальности изображения в высоком динамическом диапазоне,  и стилизованные 
фотографии, наполненные специфическими цветами и уникальными эффектами. подробнее...  
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AKVIS LightShop — Создание световых эффектов   

AKVIS LightShop добавляет световые эффекты на изображение.  
С помощью программы можно создать любого вида и формы свечения,  добавить на фотографию 
лучи,  ореолы,  вспышки,  молнии,  блики на объекты,  закат или фейерверк.  LightShop украсит 
снимок, оживит пейзаж, изменит время суток и погоду. подробнее...  

 

  

AKVIS Magnifier — Увеличение цифровых изображений   

AKVIS Magnifier позволяет изменить размер изображения без потери качества.  
Вы сможете не только уменьшить фотографию,  чтобы выложить ее в Интернет или послать 
друзьям.  Программа позволяет получить изображение высочайшего качества из маленькой 
картинки.  Magnifier обеспечивает многократное увеличение снимка без артефактов и ореолов. 
подробнее...  
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AKVIS MakeUp — Создайте свой идеальный образ!   

AKVIS MakeUp — программа для исправления портретных фотографий.  

AKVIS MakeUp помогает улучшить портрет,  устраняя мелкие дефекты с поверхности кожи и 
придавая лицу сияние,  чистоту и гладкость.  Программа способна превратить обычный снимок в 
фотографию с обложки,  создать "гламурный"  образ и даже получить изображение в высоком 
ключе. подробнее...  

 

  

AKVIS MultiBrush — Ретушь и творчество   

AKVIS MultiBrish — набор кистей для редактирования изображения.  

Программа позволяет исправить избранные области фотографии без особых усилий:  изменить 
насыщенность и резкость, размазать объект,  тонировать участок, восстановить и замаскировать, 
удалить ненужный объект и создать художественный коллаж. подробнее...  
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AKVIS NatureArt — Прикосновение к природе   

AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления.  
Программа позволяет добавить на фотографию дождь,  снег,  молнии,  солнце и облака,  изменить 
погоду,  превнести в изображение драматизм,  изменить настроение сцены,  создать морской 
пейзаж или изображение ночного звездного неба. подробнее...  

 

  

AKVIS Noise Buster — Удаление цифрового шума   

Noise Buster — программа для подавления цифрового шума. 
Программа убирает шумы матрицы цифровой камеры и шумы,  появляющиеся при сканировании 
фотоснимка,  уменьшает зернистость и устраняет неоднородные цветовые пятна на изображении, 
сохраняя при этом детали и четкость границ. подробнее...  
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AKVIS Refocus — Исправление размытых фотографий   

AKVIS Refocus помогает повысить резкость нечетких,  размытых,  расфокусированных снимков.  С 
помощью программы можно исправить изображение целиком или отредактировать только 
определенную область, сделать акцент на какой-либо детали, например, глазах, используя прием 
выборочной фокусировки. подробнее...  

 

  

AKVIS Retoucher — Восстановление и ретушь   

Retoucher — программа для восстановления изображений и ретуши фотографий.  

Программа поможет удалить царапины,  пятна,  пыль,  следы от сгибов и другие дефекты;  убрать 
лишние детали,  текст;  реконструировать недостающие части фотографии, "затянуть"  дырявые 
места и нарастить оборванные края. подробнее...  
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AKVIS Sketch — Превращение фотографии в рисунок   

AKVIS Sketch — инструмент для превращения фотографии в рисунок.  
Sketch превращает фотографию в произведение искусства,  преобразует изображения в эскизы, 
сделанные карандашом,  углем,  акварелью,  имитируя ручную работу настоящего художника.  С 
помощью этой программы можно получить не только черно-белый набросок,  но и цветной 
рисунок. подробнее...  

 

  

AKVIS SmartMask — Выделение объекта на фотографии   

AKVIS SmartMask — плагин для быстрого выделения (вырезания) объектов на изображении.  
SmartMask позволяет быстро и качественно выделить часть рисунка или вырезать фигуру 
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человека из фотографии с помощью довольно простых манипуляций.  Плагин используется для 
удаления фона, создания коллажей. подробнее...  
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